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Windographer version history 
 
Version 5.1.13 (July 22, 2022) 

• Added an updated EPE export option. 
 
Version 5.1.12 (July 14, 2022)  

• Improved efficiency of several analysis and export modules. 
• Fixed bug causing incorrect query results if sector filter refers to a vane in another dataset. 
• Added relative shear parameter restriction to Vertical Extrapolation window. 
• Fixed bug in translation of some v4 flag rules (that pertain to quality columns). 

 
Version 5.1.11 (June 29, 2022) 

• Fixed bug causing occasional miscalibration of direction data. 
• Improved defaulting of date range filter settings. 
• Made F1 button bring up the correct help article in analysis windows. 
• Improved import logic to read SCADA data files more effectively. 

 
Version 5.1.9 (May 26, 2022) 

• Fixed bug causing Append Settings window to reappear repeatedly when requiring 'perfect 
links'. 

• Fixed bug in scaling process in Vertical Extrapolation window. 
• Added option to filter list of datasets in Import From Database window. 

 
Version 5.1.8 (May 18, 2022) 

• Fixed bug causing LTA window to crash when using MTS algorithm in some cases. 
• Added uncertainty test button to the Reconstruct Across Datasets window. 

 
Version 5.1.6 (May 6, 2022) 

• Fixed bugs in Correct Tower Shading window Annex S module. 
• Added more reporting when user tests database connection. 

 
Version 5.1.5 (May 2, 2022) 

• Allowed filtering by time of day and by month range. 
• Improved import of raw data files with daily time steps. 
• Fixed bugs in the display of reconstruction uncertainty test results. 

 
Version 5.1.4 (Apr 28, 2022) 

• Fixed bug preventing database export if dataset properties contained certain Unicode 
characters. 

• Fixed bugs in MCP algorithm performance test module preventing some graphs from appearing. 
 
Version 5.1.3 (Apr 25, 2022) 

• Improved reporting of warnings related to reading WIS files. 
• Made the adding and removing of favorite flag rules more robust. 

 
Version 5.1.2 (Apr 20, 2022) 

• Fix bug in diurnal profile calculation when requiring concurrency across multiple time contexts. 
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• Improved Dataset History descriptions of dataset configuration changes. 
• Fixed bug causing MTS algorithm to crash in some situations. 

 
Version 5.1.1 (Mar 31, 2022) 

• Added new workbook summary table. 
• Made the adjustments react correctly to dataset ID changes and reversals via undo. 
• Small improvements and fixes to the process of importing data from a database. 

 
Version 5.1 (Mar 24, 2022) 

• Added user control over the size of the undo buffer to limit windog file size. 
• Added buttons to Dataset History window to allow user to trim revisions to shrink file size. 
• Improved performance of Configure Dataset and Long Term Adjustments windows. 
• Added Save Template and Load Template buttons to Configure Dataset window. 
• Added workbook summary graphs to the main window. 
• Added user control over which column types display by default in time series graphs.  
• Expanded WIS files so that they can specify data column properties and displacement height. 
• Added MCP algorithm performance test window. 
• Added Test MCP Uncertainty window that measures uncertainty using a bootstrap analysis. 
• Added a 'correct tower shading' mode to the Correct Tower Distortion window. 
• Added option to filter by maintenance periods in Scatterplot, In Situ, and Tower Distortion 

windows. 
• Added high wind hysteresis modeling to Wind Turbine Output window. 
• Added temperature shutdown and derating to Wind Turbine Output window. 
• Improved data import logic. 
• Fixed bugs in EPE export. 
• Added the MCP algorithm performance test window. 
• Improved efficiency of LTA Extrapolation tab. 
• Solved bugs in LTA window causing inconsistencies versus v4. 
• Improved efficiency of LTA window. 
• Improved handling of dataset templates. 
• Improved efficiency of Configure Dataset window. 
• Added summary graphs to the main window. 
• Added primary columns to Workbook Explorer's dataset list. 
• Fixed bug causing flags to move in time after deletion changes the start of the period of record. 

 
Version 5.0.13 (Feb 7, 2022) 

• Improved speed of Export Data window. 
• Added ability to open ZPH files. 
• Fixed bugs in EPE export. 
• Fixed bug in direction calibration logic. 
• Fixed bug in LTA window that caused Correlate Direction tab speed filter not to work. 
• Fixed bug causing occasional crash in LTA window. 

 
Version 5.0.12 (Dec 15, 2021) 

• Added option to export time series files in Windows number format or North American format. 
• Fixed bug causing incorrect number formatting if the Windows number format was not the North 

American standard. 
• Allowed the import of Excel files. 
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• Allowed the import of unprocessed Ammonit Meteo-32 files. 
 
Version 5.0.11 (Dec 2, 2021) 

• Fixed bugs in Data Coverage window leading to erroneous results in some modes. 
• Fixed bug causing In Situ window to warn of spurious calibration changes. 
• Fixed bug preventing the append process from working in some situations. 

 
Version 5.0.10 (Nov 29, 2021) 

• Added a menu item to restore factory default toolbar and menu layout. 
• Fixed bug causing Daily Statistics table to repeat the first day's stats for every day. 

 
Version 5.0.9 (Nov 23, 2021) 

• Fixed bug preventing the adding of new turbines and turbine groups. 
• Fixed bug causing Export Data window to disable some date/time controls. 
• Fixed bug causing use of incorrect Weibull fit algorithm in some cases. 

 
Version 5.0.8 (Nov 15, 2021) 

• Improved speed of the Openwind export process. 
• Fixed bug in v5 Openwind export logic causing incorrect air density values in some cases. 
• Fixed bug causing invalid WPD values in time steps with missing temperature data. 
• Improved import of AQ500 and AQ510 data files. 

 
Version 5.0.4 (Oct 7, 2021) 

• Improved identification of time zone during import. 
• Improved efficiency of Append Settings window. 
• Fixed bug causing unhelpful error message when license is expired. 

 
Version 5.0.3 (Oct 5, 2021) 

• Fixed bug causing crash when reading some flag rule XML files. 
• Fixed bug causing Tower Distortion window to ignore changes to colocation threshold. 
• Added option to remove seasonal bias from histograms. 
• Added option in time series graphs to show or hide all columns in a dataset. 
• Fixed bug that prevented floating licenses from working. 
• Fixed bug causing Flag by Scatter Plot window to respond incorrectly to changes in axes 

variables. 
• Added option to EPE export tab to choose between old and new formats. 

 
Version 5.0.2 (Sep 16, 2021) 

• Fixed bug preventing the saving of large windog files. 
• Implemented two-step save process if requested in Options window. 
• Improved Dataset History descriptions of configuration and calibration changes. 
• Improved import logic to accept very short Kintech data files. 

 
Version 5.0.1 (Sep 3, 2021) 

• Fixed bugs in Vertical Extrapolation and LTA windows. 
• Fixed bug preventing identification of measurement height in Vortex LES files. 
• Added XML import and export buttons to the Flag Rule Properties window. 
• Fixed bug causing incomplete reading of flag rule XML files. 
• Made main window remember its window placement. 
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Version 5.0 (Aug 17, 2021) 

• Added ability for a workbook to contain multiple datasets. 
• Allowed display of multiple analysis windows at a time. 
• Added option to undo changes to datasets. 
• Allowed import of data with timesteps smaller than one second. 
• Changed to 64-bit programming to handle more data. 
• Added module for in situ comparison of anemometers. 

 
Version 5.0 beta (Aug 16, 2021) 

• Converted Optimal Time Offset window. 
• Fixed bug causing Save As window to appear when it shouldn't. 
• Solved crash when opening Triton data files. 
• Made Wind Rose window show filter-by-flag controls and made column list expand to take 

available space. 
 
Version 5.0 beta (Aug 2, 2021) 

• Progress on second (UL) mode of LTA window 
• Progress converting Optimal Time Offset module 
• Fixed bug in many calculated column windows that prevented proper initialization 
• Fixed bug that ruined all solar calculations 
• Added displacement height override to Vertical Extrapolation window 
• Added import file type for QML files so we can identify their laconically named pressure column 
• Small improvement to the logic that guesses the dataset type 
• Fixed bug causing Long Term Patterns window to crash. 
• Added NetCDF export tab 
• Made only parent columns appear in lists of columns-to-flag in Flag Manually, Flag With 

Scatterplot, and Flag Rule Properties windows. 
• Improved Dataset History descriptions. 
• Added special naming logic (for UL users only) so that composite WD columns get called 

'COMPDir' 
• Changed RLD import logic to read battery voltage column as well 
• Improved import of Ammonit M40 files 
• Improved RLD import logic to use the 'Total Direction Offset' value (if any) even if it comes 

before the 'Offset' value. 
 
Version 5.0 beta (Jun 25, 2021) 

• Improved import of Campbell Scientific data files. 
• More improvements to the import of Kintech data files. 
• Added Representative Year window. 
• Slightly improved error message after File > Open. 
• Improvements to append process and discrepancy reporting. 
• Allowed the computation of a column sum over a time period, and displayed it in the period stats 

tables. 
• Added shear & speed versus hour display type in Wind Shear Analysis window. 
• Added option not to export file header. 
• Added Wind Turbine Output window. 
• Improved import of Kintech data files. 
• Added Representative Year window. 
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• Modified style of monthly & diurnal profile graphs. 
 
Version 5.0 beta (Mar 26, 2021) 

• Added In Situ Comparison window. 
• Added Special Adjustments window 
• Added Reconstruct Across Datasets window. 
• Added database import/export windows. 
• Added Combined tab to Export Data window 
• Added Wind Turbine Output window 
• Added Seasonality Profile window 
• Improved Turbulence window 
• Improved Long Term Patterns window. 
• Improved import logic 
• Added multiple dataset shear-by-hour graph and table to Shear Analysis window. 
• Improved RWD and RLD import and decryption. 
• Fixed bug preventing the Config window from listing the columns associated with a quality 

column. 
• Added shear-by-hour display option to multi-dataset mode of Wind Shear analysis window 
• Added to Export Data > Time Series option not to export file header. 
• Made Configure Dataset window appear when importing raw data files 
• Fixed bug preventing the import logic from reading elevation from v4 exported text file 
• Small improvement to the wording of the Initiate Free Trial window 
• Modified NRG import logic for direction sensors to use the "Total Direction Offset" if it finds it, 

replacing the "Offset" 
• Made Export Data window open to the most recently used tab 
• Fixed bug in scaling of the graph in the Export Image window 
• Ensured valid UTF encoding of units strings 
• Stopped forcing the user to confirm cancel on flag windows 
• Removed save button from Flag Manually window (and warn-on-save checkbox in Tools-

>Options) 
• Improved Dataset History window 
• Fixed bugs in Correct Tower Distortion window 
• Added new date/time calculated column to contain decimal hour of day. 
• Fixed bugs in Cumulative Frequency window 

 
Version 5.0 beta (Mar 12, 2021) 

• Added optional min-speed-at-height filter to Wind Shear window. 
• Renamed window from 'Fill Gaps' to 'Reconstruct Single Dataset' 
• Finished the Inspect and Remove Flags window and increased its speed. 
• Fixed bug causing calculated columns to replicate themselves on occasion. 
• Improved speed of data file import process. 
• Improved dataset nickname logic. 
• Added EPE tab to Export Data window. 

 
Version 5.0 beta (Feb 25, 2021) 

• A million things. 
 
Version 4.2.21 (Mar 22, 2021) 

• Improved scatter plot legend to show regression line equation. 
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• Updated EPE export tab to reflect latest guidance from the Brazilian EPE. 
• Added new module to calculate gap fill uncertainty with k-fold cross validation. (Formerly 

Enercon only) 
• Added option to include flag status in time series export files. 
• Improved data import logic. 
• Added to Export Data window the option to force North American number format. 
• Allowed import of Openwind MM3.2 files. 
• Added 70th percentile of TI to turbulence-by-speed table to help support IEC 4th ed. 
• Fixed bug in Hottel clear sky radiation model that introduced a half-hour time shift. 
• Fixed bug where solar calculations failed to account for the difference between the longitude 

and the time zone standard meridian. 
• Improved Configure Data Set window to rename child columns automatically with parent 

column. 
• Added mean of monthly means table to Tables tab. 
• Improved import logic to recognize GHI, DNI, DHI, and battery voltage data columns. 
• Added to the Configure Data Set window a button to set time zone from lat/long coordinates. 
• Added option to export windog file, optionally with metadata removed or timestep changed. 
• Changed the handling of cutoff wind speed in the MCP logic 

o Made cutoff speed apply to both onsite and reference speeds, rather than just reference. 
o Forced omnidirectional below-cutoff regression through the origin. 

• Added option to choose columns from which to calculate shear when reconstructing and filling 
gaps. 

• Added Combine Direction Sensors window. 
 
Version 4.2 (May 31, 2019) 

• New option to set the time zone in the Configure Data Set window. 
• New option to make displacement height vary by direction sector or month. 
• Improvements to WindographerMCP 

o New display options on Onsite Data and Long-Term Data tabs. 
o New ability to select subset of data sets for analysis. 
o New ability to define any number of long-term adjustments. 
o New concurrency and filter options. 
o New ability to detect and correct time offsets between data sets. 
o New logic to determine minimum number of data points for regressions. 
o New long-term scaling options including scaling each month separately. 
o Improved control, reporting, and documentation of reconstruction process. 

• Improvements to Vertical Extrapolation window 
o Option to restrict the shear parameter range to mean plus/minus X standard deviations. 
o Option to rescale to a desired mean value after extrapolation. 

• Improved data import logic. 
• Added ERA5 data to Windographer Data Downloader. 
• New option to use Larsen & Hansen ‘detrending’ process on TI columns. 
• New Correct Tower Distortion module. 
• New data column types for solar irradiance and battery voltage. 
• New option to specify multiple RH data columns at different measurement heights. 
• Improved Harris1999 Gumbel fit method to make it produce results in a wider range of 

conditions. 
• New option to import and export turbine properties in WTG and OWTG formats. 
• Added ability to read from and write to MySQL databases. 
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• Added Shear tab to Tools > Options window, and made shear evaluation method and shear 
lookup table type an option the user can set in Tools > Options for speed, speedSD, direction, 
and temperature extrapolation. 

 
Version 4.1 (January 19, 2018) 

• Added new MCP module capable of handling multiple onsite and reference data sets. 
• Added handling of boom orientation 

a. Added boom orientation to Calibration window. 
b. Added combine-by-boom-orientation to Combine Anemometers window. 
c. Added by-boom-orientation mode to Flag Tower Shading window. 
d. Added logic to read boom orientation from RLD and NDF files. 

• Added displacement height to the Configure Data Set window. 
• Improved speed of Configure Data Set window and added: 

a. Buttons to copy data columns and convert to static data columns. 
b. Ability to specify measured TI columns 

• Improved Vertical Extrapolation window: 
a. New more flexible and more realistic method of extrapolating speed SD data. 
b. Now allows extrapolation from a specific sensor or the line of best fit. 
c. User can now specify the type of lookup table used for backup when in by-time-step 

mode. 
d. Now shows a preview of synthesized data columns. 
e. Added option to compare extrapolated time series with column in another (or same) data 

set. 
• Added save button to Flag Manually window 
• Improvements to Document History window: 

a. Complete reporting of vertical extrapolation, gap filling, and scaling processes 
b. Added Reviewers tab 

• Made Tower Distortion Analysis window modeless, and added option to subdivide by year or 
month 

• Improved Data Recovery Analysis window 
a. New option to display data coverage chart of valid or invalid data 
b. New table showing missing data 
c. New option to report valid time steps rather than data recovery rate 

• Added 'Openwind' Weibull fit algorithm. 
• Added the ability to choose a Weibull fit algorithm in Tools > Options. 
• Improvements to Combine Anemometers window: 

a. Now creates combined max column as well as combined SD column 
b. New option to combine by boom orientation  
c. New option to use reconstruct-and-average when combining 

• Added to Fill Gaps window the option to replace data flagged to exclude. 
• Added option to download MERRA-2 data from Windnavigator. 
• Improved gap fill process to reconstruct co-located speed sensors first, using regression-by-

sector, before doing shear-based reconstruction. 
• Improved Wind Shear Analysis window 

a. Added speed SD shear. 
b. Added option to calculate from MoMM or simple mean. 

• Improved Compare Data Sets window 
a. Added speed frequency graph 
b. Added TI-vs-height and TI-vs-speed graphs 

• Added Special Adjustments window to perform NRG TI adjustment. 
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• Added to Tables tab quarterly and daily stats, ‘Data Channel Summary’, ‘Calibration History’ 
• Added MoMM to Data Columns table and Environmental Summary table. 
• Added calculated columns for speed SD shear, dew point, inflow angle, first difference, density-

adjusted wind speed, and energy-weighted air density. 
• Added option to auto-create a ratio column for co-located speed sensor pairs. 
• Added option whether to use ISA to synthesize temp./pres. data for air density calculated 

column. 
• Improvements to data import process: 

a. Added ability to open RLD files and Fulcrum3D files. 
b. Added separate control of append overwrite settings for numeric data and flag status 
c. Improved import of RWD, MM, NSD, and ASOS files. 

• Expanded Openwind export options. 
• Added Wind Turbine Output window display options, and option to disable density adjustment. 
• Improved Representative Year window to encompass multiple data columns. 
• Added 'frequency & energy' display option to the Wind Rose tab. 
• Improved Apply Scale and Offset window to allow scaling by month, hour of day, or sector. 
• Added trend and discontinuity testing to Long Term Analysis window. 
• Improved MTS algorithm 

a. Added option to subdivide by year divisions. 
b. Added option to window bins on joint probability distribution. 

• Updated database interface to revision 6 by adding displacement height and boom orientation. 
• Added option to specify different flags for different reconstruction processes. 
• Added user preference to use AWST air density assumptions. 
• Added ability to specify height of RH column. 
• Added randomness to extrapolated turbulence for more realistic representative TI. 
• Added option to include solar radiation data when downloading MERRA data from NASA. 
• Made all mean direction calculations report vector means. 
• Switched to Yamartino method for calculating standard deviation of directional data. 

 
Version 4.0 (May 18, 2015) 

• New Calibration window. 
• Expanded calculated column capability with many new options. 
• Ability to import much larger text files. 
• New ability to hide data columns from graphs and drop-down boxes. 
• Document History window now displays a complete list of configuration changes. 
• New Combine Anemometers window for combining co-located anemometers. 
• Easier sharing of favorite flags and flag rules within a team. 
• New ability to scale (rather than lengthen) the target data set in MCP module. 
• MCP performance test now compares different settings as well as different algorithms. 
• MCP performance test now allows multiple iterations to help determine uncertainty. 
• Vertical Extrapolation window now includes turbulence, directions, and temperatures. 
• New ability to export multiple-height data to Openwind in the form of an MM2 file. 
• Improved performance and flexibility of gap fill module. 
• Turbulence Analysis window now shows data for all heights at once. 
• New Representative Year module for creating 'typical year' of data. 
• New Forecast Error Analysis module. 
• New concurrency option on Diurnal Pattern tab. 
• New ability to open ZPH files from ZephIR. 
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• New ability to offset direction values in TAB files. 
• Improved data import logic. 

 
Version 3.3.14 (June 7, 2017) 

• Added menu items for Open Folder and Append Folder. 
• Added ability to open multiple files by dragging and dropping a folder into Windographer. 
• Added new Append Status window and improved robustness of multi-file append process. 
• Added Brazilian EPE export format. 
• Improved data import logic. 
• Improved processing speed. 
• Improved gap fill algorithm. 
• Improved flag rules to handle direction ranges spanning true north. 
• Improved Mean by Month, Monthly Statistics, and Annual Statistics tables. 

 
Version 3.2 (January 16, 2014) 

• Added free download of MERRA data via Windographer Data Downloader beta. 
• Added option to scale a TAB file to a particular wind speed. 
• Added to MCP window option to divide by up to twelve yearly divisions. 
• Added a third stacked time series graph, and added checkboxes to toggle all speed or direction 

columns. 
• Tower Distortion Analysis window now shows differences as well as ratios. 
• Made Append window re-appear during the multi-file append process whenever column labels 

change. 
• Improved data import logic. 
• Added up/down arrow keys as keyboard shortcuts to zoom in and out on time series graphs. 
• Added subtle background colors to indicate data column type in some tables. 
• Changed append process to import all data columns, even empty ones. 
• Improved the Append window to simplify the mapping of new columns to existing columns. 
• Added the ability to specify marker type in graphs (diamond, circle, triangle, X) 
• Added shortcut keys to time series graph: -/+ for zoom and arrow keys for scroll. 
• Added 24 and 36 to the allowable number of direction sector subdivisions in the MCP window. 
• Added Monin-Obukhov length column to the Openwind export file (currently just zeroes). 
• Added hotkeys to speed flagging in Flag Manually and Flag by Scatter Plot windows. 
• Added mouse wheel shortcut for zooming in and out of time series graphs. 

 
Version 3.1 (April 17, 2013) 

• Added tabular display to the Flag Manually window. 
• Added the ability to test flag rules before executing them. 
• Added the Inspect and Remove Flags window. 
• Added monthly option and ‘stacked bars’ wind rose style to Wind Rose tab. 
• Added Export Image window. 
• Expanded Compare Sites tab of MCP window. 
• Added Fix Quantization window. 
• Added details pop-up to Document History window. 
• Added display options to Wind Turbine Output window. 
• Improved TAB file export by reporting mean of time series and of TAB file, and by adding the 

ability to make the first bin half-sized. 
• Added export to export Windfarmer WTI files. 
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• Added the ability to export to SAM, the Solar Advisor Model. 
• Added option to time series export tab to skip empty lines. 
• Added to the Delete Data window the ability to delete data points not flagged with specified 

flags. 
• Improved import logic. 
• Made all flag windows warn on cancel if it will result in lost changes. 
• Changed air density calculations to account for the height of the temperature and pressure 

sensors 
• Updated database interface to version 3 
• Changed MIS default independence criterion from 0 to 48 hours, and recommended storm 

frequency from 100 storms/yr to 20 storms/yr. 
• Improved gap fill algorithm to account for correlation between temperature sensors 

 
Version 3.0 (August 27, 2012) 

• New improved MCP (measure-correlate-predict) module. 
• Added new Compare Data Sets window. 
• Added new Extreme Wind Analysis window that implements the Method of Independent Storms. 
• Added new Flag by Scatter Plot window. 
• Added User-defined calculated data columns. 
• New improved Wind Turbine Output window that lets you compete turbines against each other. 
• Allowed multiple temperature and pressure sensors at different heights. 
• Added new relative humidity data column type. 
• Added new modules to analyze wind veer, temperature profile, and long-term trends. 
• Added option to filter for a precise date range. 
• Improved text file data import 
• Added new Wind Speed Ratios window 
• Added minimum data coverage requirements for averaging to longer time steps. 

 
Version 2.52 (April 3, 2012) 

• Improved and expanded capabilities of MCP window. 
• Added Compare Data Sets, Forecast Error Analysis, and Wind Speed Ratios windows. 
• Added Ramp Event Analysis window 
• Added Wind Turbine Library window and the ability to create groups of turbines. 
• Improved Wind Turbine Output, Wind Rose, and Wind Shear Analysis windows. 
• Added the 3D colored scatter plot to the Scatter Plot tab. 
• Added Openwind export format. 
• Changed flag filter logic to exclude unchecked flags, rather than just not including them. 
• Improved data import logic. 
• Improved the gap fill algorithm to account for correlation between wind direction sensors. 
• Added hodograph to, and removed acceleration from, Short Time Intervals window. 
• Made shear by time step calculations filter by flag, rather than inheriting flags from speed 

columns. 
 
Version 2.4.14 (January 8, 2015) 

• Added database import/export capability. 
• Added to the Histogram tab the option to bin by month or by time of day. 
• Added username to Document History window. 
• Improved data import logic. 
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• Improved Tower Distortion Analysis window to handle speed sensors at different heights. 
• Added ability to import .wt files into Append Data window via Load Settings button. 
• Added ‘Wind Speed Statistics for Synthesis’ table to Tables tab. 
• Improved support for Oracle database integration. 
• Added Openwind export format. 
• Made database export process export only the newly added, deleted, or modified flags. 
• Improved gap fill process to use the highest-availability speed sensor as the anchor sensor. 

 
Version 2.3 (May 18, 2011) 

• Improved data import logic. 
• Added Append Data window. 
• Improved gap fill logic to account for daily and seasonal patterns using windowed CDFs and 

percentiles. 
• Added option for computer-level licensing. 
• Changed export files to use the Windows number format. 

 
Version 2.2 (December 8, 2010) 

• Added Inflow Angle Analysis window and Data Recovery Analysis window. 
• Improved data import logic. 

 
Version 2.1 (August 23, 2010) 

• Added ability to open NDF and NSD files. 
• Made optional the use of fractional completeness factors in MMM calculation. 
• Added option to calculate RMS wind speed SD during downsampling. 

 
Version 2.0 (April 30, 2010) 

• New quality control mechanism based on data flagging and filtering by flag status. 
• Improved Vertical Extrapolation module. 
• New Tower Distortion Analysis and Short Time Interval Analysis modules. 
• Improved data import logic. 
• Improved WAsP tab file export including option to remove seasonal bias. 
• Added new Meteodyn export format. 
• Improved downsample logic to properly handle max and SD columns. 
• Added ability to import from a SQL database. 

 
Version 1.52 (January 7, 2014)  

• Fixed various bugs. 
 
Version 1.4 (February 25, 2009) 

• Added the Time Shift window. 
• Improved data import logic. 
• Improved Turbulence, Wind Shear, and Date/Time Anomalies windows. 
• Improved Scatterplot tab, PDF tab, Export Data window, and Extreme Wind Analysis window. 

 
Version 1.3 (September 22, 2008) 

• Improved Export Data, Turbulence Analysis, and MCP windows 
• Added Reports tab, Frequency Distribution Analysis window, and Compare Data Sets window. 

 
Version 1.2 (May 6, 2008) 



Updated: July 22 2022 

• Improved control of append process. 
• Added Tables tab. 
• Improved analysis windows and export module. 

 
Version 1.1 (March 12, 2007) 

• Improved quality control and filtering. 
• Improved Wind Shear Analysis window. 
• Added the Tower Shading Analysis window and Turbulence Analysis window. 

 
Version 1.0 (September 26, 2005) 

• Initial release. 


